
The Villages Computer Club will meet at 1 p.m. Friday Oct 26, 2012 at 
Lake Miona Recreation Center. The program will feature a presentation 
by John Campbell on Transferring music to PC and making CDs/DVDs. 
 

Following the presentation will be refreshments, a 50/50 drawing, door 
prizes and a problem solving session.  
 

If you have a computer problem you can't resolve, fill out the 
troubleshooting request form found at thevillagescomputerclub.com 
and bring it to the meeting. 
 

Guests are always welcome. For information or to sign up to be on the 
VCC email list, visit the website or email Paul Rabenold at 
TVCC.Pres@gmail.com. 
 

The Expo on Saturday at Colony Cottage was great and it gave us an 
opportunity to talk to a lot of people answering technical questions and 
discussing the computer club.  
 

Thanks to all who participated.  
 
********************************************************************************** 
USING YOUR WORD PROCESSOR 
Alphabetize a large group of names or items. (MSWORD 2007) 

 

It’s a good idea to print these instructions before beginning. 

 

Example: The groups from your address book, each name being separated by a comma. 

(When the comma is used in this manner it is known as a delimiter). It has used AOL 

addresses, but you can use it to alphabetize any list of addresses. 

 

1. Copy and paste the group of names to a MSWORD document sheet. 

2.Click CTRL+A to select all the names in the group.(If more than one group, then 

alphabetize one group at a time) 

3. Press the TABLE button on the Menu toolbar (ribbon). Select CONVERT TEXT TO 

TABLE.  

4. In the box that pops up, select COMMA, click AutoFormat and select NONE. OK. 

Change the # of columns to 1. Click OK. All the names now will appear in a single column. 

5. Click HOME… select SORT …Ascending/descending order.  

6. Click LAYOUT and select CONVERT TABLE TO TEXT. Select Separator COMMA.  
7.Click REPLACE. A Find and Replace screen will appear.  

8. Put cursor in the FIND WHAT box. Click the MORE button. (Click the LESS button if 

necessary to make it a MORE button, it toggles between More and Less). 

 



9. Click on the SPECIAL button and from the dropdown menu select PARAGRAPH MARK. 

The symbol(^P) will appear in the FIND WHAT box.  

10. In the REPLACE box, type in a comma and a space(, ).  

11. Click REPLACE ALL.  

The list should now appear in paragraph text format with a comma separating each name and a 

space between them. 

 
If this is a group of names from your AOL address book, select and copy the group, Bring up the 

AOL Address book, click on the AOL group, click EDIT, click on the box containing the 

addresses, they will highlight, Now press CTRL V to paste the newly alphabetized group into the 

box to replace the old group. Remember to place a parenthesis before the first name and after the 

last name, so when you send they will all go as blind copies and you won’t be sending out a list 

of names for all the recipients to see. NOTE: AOL alphabetizes the address book for you. By 

clicking the Name column in the AOL alphabetized list you can arrange in ascending or 

descending order. 

***************************************************************************** 

 

Create Arrows to Use to Point in Word 2007 Documents 
 

1. Click Insert and select Shapes. 
2. Click to select the type arrow you need 

3. Click on the page where you want to put the arrow. 

4. Drag the arrow to the length you need.  
5. Click and use the turn circle to turn it to the degree you want. 

6. Select color, size,etc. 
***************************************************************** 

BUSINESS CARDS Using MS WORD 2003 
 

1. Click Tools, Envelopes & Labels, select Label tab. 
2. Click Options, and select Standard Avery 8371, 8372, 8373, 8376 or 8377 label click 

OK. Or select a different Avery label if you prefer a different size. 
3. Select PRINT FULL PAGE, Manual Feed 
4. Click New Document, a page will be brought up showing a full page of labels. 
5. Create your business card in the first one, just the way you want it to look. Save it to 

File, giving it a name that you’ll recognize later and be able to print more. 
6. Now click Tools…Envelopes & Labels, and click PRINT. 
Note: Always print on a clean sheet of paper first. Hold this sheet over your business 

cards to make sure they will align correctly on the page before printing on the business 

cards themselves.  

 

Note: Print a whole page each time when printing to the business cards. If you try to 

print a partially empty sheet of cards, they will come lose and get all stuck in the printer 

due to the glue being softened by the printing of a partial page. 

 

Revised 6/14/2009 JMM 

********************************************************** 



 

Using MSWord 2007 
 

1. Start Word. Click New …Create to get a new blank page  

2. Click Mailings on the menu bar and select Start Mail Merge. 

3. Click Labels. 

4. In the Label Options dialog box, you have several choices to make. 

The type of printer that you are using to print labels 

The supplier that produced your label sheets 

The number that is the product number on your package of label sheets 

 

5. Under Printer information, select your printer type. 

6. In the Label vendors list, click the name of the company that made the label sheets that 

you are using. 

7. In the Product number list, click the product number that is listed on the box of label 

sheets. 

If none of the product numbers match the number on your label package, follow 

instructions below 

1. Measure the labels on the sheet you have, and note the measurements and how many 

labels fit on a single sheet.  

Note Measure the labels carefully. The actual label size might be smaller than 

the size that is indicated by the label manufacturer. For example, a 1-by-2-inch 

label might actually be 15/16-inch high and 1 15/16-inches wide. 

2. In the Product number list, select a label type that is similar in size to your labels.  

3. Click Details, and then compare the label dimensions and the number of labels per 

sheet (for labels printed on laser and ink-jet printers) or the number of columns on 

the label form (for labels printed on dot-matrix printers). 

4. Do one of the following:  

•••• If the dimensions and label layout match those of your labels, use the selected label. 

•••• If the dimensions and layout do not match yours, click Cancel, and continue to step 5. 

5. In the Label Options dialog box, click the printer type (either Continuous-feed 

printers or Page printers), and then click New Label. 

6. Type a name in the Label name box, select the height, width, margins, and other 

options for your label, and then click OK.  



8. After you select the label options that you want, click OK. 

Word creates a document that contains the sheet of labels. Word uses a 

table to lay out the labels. If you don't see lines separating the labels, click 

the Layout tab under Table Tools, and then in the Table group, click View 

Gridlines. 

Note: First print a page of labels (business cards) on a plain sheet of paper. Hold 

this printed sheet over your sheet of card stock to be sure that you’ve choosen 

the correct label. If they match up, you’re ready to print your labels(bus cards). 

Note2: Never print part of a sheet. The printing will heat the labels and if you put 

part of a sheet in to print again, the labels may peel off and stick to the printer 

roller making a big mess. 

 

Using the Avery Wizard in MSWord 2007 

Click AVERY on the menu bar and follow directions given 

****************************************************************************************************

* 

How to Customize Bullets in Word 2007 Bulleted Lists 

The quickest way to create a custom bulleted list in Word 2007 is to change 

the formatting of an existing (or automatically created) bulleted list. Word 

automatically formats text as a bulleted list when you begin a paragraph with 

* or > or -> or <> or - followed by a space, Word changes what you typed to a 

bullet and a tab, adds a bullet character by the paragraph, and creates a ¼-

inch hanging indent. (If the paragraphs already have hanging indents, the 

original settings are preserved.) 

Hover your mouse pointer over the little downward arrow next to the Bullet 

button. 

The Bullet button (first one in the upper row of buttons on the Ribbon’s 

Paragraph tab) offers a tooltip. 

Click the arrow next to the Bullets button to reveal the gallery of bullet styles. 

The Bullet Library portion of the gallery shows (and stores) your favorite 

bullets. 

If you have other open documents with bulleted lists, check them to see 



whether they have bullets you like. 

The Document Bullets section lists all bullets in all documents currently open. 

To add a bullet to your Bullet Library, right-click the bullet and choose Add 

to Library. 

When you add a bullet to your Bullet Library from the Document Bullets 

collection, the bullet is available for all your documents. 

To remove a bullet from the Bullet Library, right-click it and choose Remove. 

Removing the bullet from your Bullet Library doesn’t remove it from the lists 

in your document. 

Click a bullet in the list to check that it matches all the bullets in the list. 

Clicking one bullet highlights all bulleted items in the list. 

******************************************************************

********* 

 
Copy and Paste Does not Work 

When you highlight and select a document in MSWord or other word processor and then 

attempt to paste that to a different program such as Word Pad or an email, it just won't 

paste. It doesn't even copy it to the computers clipboard. What can you do? 

Solution: 

Restart your computer. 

There are all kinds of 'fixes' listed in Google but try the simplest first. 

************************************************************** 

MS Works 2007 Address Book 

 
Must first create and name your Contacts Address book in Ms Works. Save the Contacts as 

a file in your My Documents folder. 

Example: C:\My Documents\Jean\Contacts 

 
 
1. Open MS Works 

2. Click Programs tab 

3. Click Address Boook 

4. Click New Contact 

5. Click Name & email tab. 

6. Click Home to enter address & phone number. 

7. Press OK. 

****************************************************************** 



 
MSWorks v 4.5 Labels  

 

 

You can use these Labels as Name tag, Membership Labels, etc. They don't 

have to just be used for mailings. It's a good idea to purchase the particular 

label card stock or label peeloffs before creating the label. Then you can select  

to use the size label by the form # on your box of labels. 

Example: If you buy Avery # 5620, then when you're selecting the Label product 

and style, you would select Avery # 5620.  

 

 

On the Tools menu, click Labels.  

- or - 

Use the Works Task Launcher to start a labels task.  

In the Labels dialog box, click Mailing labels.  

Click OK.  

The Label Settings dialog box appears. 

Under Printer Information, select the printer you are using.  

Under Label Information, select the label product and style.  

- or - 

Create a custom label. 

Works opens a new label document and displays the Open Data Source dialog box. 

Click the data sourcein mail merge, a file that contains fields such as names, addresses 

and other information that are merged into a document you want to use.  

The Insert Fields dialog box appears. 

In the label area of the document—the area that is not grayed out—click where you 

want to insert a fielda column in List view that shows a category of information, 

such as a serial number or purchase date.  

In the Fields list, click the type of field you want to add to the document.  

If you're using the Address Book as the data source, you can click Address Block to 

insert both the name and address in a single step. 

Press Insert.  

For each field you want to insert, repeat steps 8 through 10.  

Add any spaces, punctuation, and paragraphs to the label document.  

For example, type a comma and a space between the field codes for city and state. 

In the Insert Fields dialog box, click View Results.  

To move between labels in the document, click the arrows in the View Results box. 

When you finish inserting fields, click Close.  

After you close the Insert Fields dialog box, you can view the labels by pointing to 

Mail Merge on the Tools menu, and then clicking View Results. 

On the File menu, click Save.  

In the File name box, type a name for the label document.  

Click Save. 

 

******************************************************* 



MSWord 2007 Default Format 
 

1. On the HOME tab, click the Font Dialog Box Launcher, click the Font tab. 
2. Select the options that you want to apply to the default font. 
3. Click Default, then click YES. 

 

 

 

MSWorks 4.5a Default Format 
 

1. Open Works, 
2. Click Format and select Font 
3. Change the font to the size you want, and change anything else you want to 

change in the default format.  
4. Click SAVE 

 

************************************************************** 

 

Is your credit card in danger of being used without your permission or 
knowledge. Watch this video. 
Symbol on your Credit Card/WATCH THIS  

Wi-Fi Symbol on your Credit Card 
YOU WONT BELIEVE THIS IS HAPPENING. WATCH VIDEO AND CHECK YOUR 
CARDS. 
Check your newer credit cards for the Wi-Fi Symbol on it. You need to watch the 
video below to really know why I sent this to you. 
Subject: RFID Credit Cards IMPORTANT 
I read this about a couple weeks ago, and then checked my cards for the little 
"Wi-Fi Signal Icon" on each one. I found none w/that signal on them, but I was 
determined to watch for it when my cards came in on renewals. Well, yesterday I 
got my CHASE SLATE card AND THERE IT WAS ! My first time to see it. I'll not 
activate that card after seeing this. I guess I'll go to the bank and see if I can 
replace it w/a non Wi-Fi (Radio Frequency Card)....? 
Thought all my contacts ought to see this if you've not already seen this 
demo....wow! 

http://youtube.googleapis.com/v/lLAFhTjsQHw%26sns=em 
*********************************************************************************** 
How much of this is true I donot know but I am passing it on............ 

Sounds reasonable to me. Have a great weekend. 

Amazing frozen lemon 

All it is.....is a frozen lemon 



Many professionals in restaurants and eateries are using or 
consuming the entire lemon and nothing is wasted. 
How can you use the whole lemon without waste? 

Simple.. place the lemon in the freezer section of your 
refrigerator. Once the lemon is frozen, get your grater, and 
shred the whole lemon (no need to peel it)and sprinkle it on 
top of your foods. 
Sprinkle it to your whisky, wine, vegetable salad, ice cream, 
soup, noodles,spaghetti sauce, rice, sushi, fish dishes. 
All of the foods will unexpectedly have a wonderful taste, 
something that you may have never tasted before. Most 
likely, you only think of lemon juice and vitamin C. Not 
anymore. 
Now that you've learned this lemon secret, you can use 
lemon even in instant cup noodles. 
What's the major advantage of using the whole lemon other 
than preventing waste and adding new taste to your dishes? 

Well, you see lemon peels contain as much as 5 to 10 times 
more vitamins than the lemon juice itself. And yes, that's 
what you've been wasting. 
But from now on, by following this simple procedure of 
freezing the whole lemon, then grating it on top of your 
dishes, you can consume all of those nutrients and get even 
healthier. 
It's also good that lemon peels are health rejuvenators in 
eradicating toxic elements in the body. 
So place your lemon in your freezer, and then grate it on your 
meal every day. It is a key to make your foods tastier and you 
get to live healthier and longer! That's the lemon secret! 
Better late than NEVER! The surprising benefits of lemon! 
Lemon (Citrus) is a miraculous product to kill cancer cells. It 
is 10,000 times stronger than chemotherapy. 
Why do we not know about that? Because there are 
laboratories interested in making a synthetic version that will 
bring them huge profits. 



You can now help a friend in need by letting him/her know 
that lemon juice is beneficial in preventing the disease. Its 
taste is pleasant and it does not produce the horrific effects 
of chemotherapy. 
How many people will die while this closely guarded secret is 
kept, so as not to jeopardize the beneficial multimillionaires 
large corporations? 

As you know, the lemon tree is known for its varieties of 
lemons and limes. 
You can eat the fruit in different ways: you can eat the pulp, 
juice press, prepare drinks, sorbets, pastries, etc... It is 
credited with many virtues, but the most interesting is the 
effect it produces on cysts and tumors. 
This plant is a proven remedy against cancers of all types. 
Some say it is very useful in all variants of cancer. It is 
considered also as an anti microbial spectrum against 
bacterial infections and fungi, effective against internal 
parasites and worms, it regulates blood pressure which is 
too high and an antidepressant, combats stress and nervous 
disorders. 
The source of this information is fascinating: it comes from 
one of the largest drug manufacturers in the world, says that 
after more than 20 laboratory tests since 1970, the extracts 
revealed that It destroys the malignant cells in 12 cancers, 
including colon, breast, prostate, lung and pancreas... 
The compounds of this tree showed 10,000 times better than 
the product Adriamycin, a drug normally used 
chemotherapeutic in the world, slowing the growth of cancer 
cells. 
And what is even more astonishing: this type of therapy with 
lemon extract only destroys malignant cancer cells and it 
does not affect healthy cells. 
*************************************************** 

12 Florida Amendments to be on the voting ballot. 
http://collinscenter.org/2012flamendments/home-2/ 



If you go to this site and then click where it says “click here”, you will see the clear 
explanations. Don’t waste time reading all the comments.  
We all should be informed voters.  
The following is for all Registered Voters in the State of Florida. We have 12 Amendments up for vote and they 

have been so confusing to so many.  
Here is relief; as it is a site that lists them in English that us commoners can understand: 

******************************************************************************** 

JmaxJmaxJmaxJmax  

Jmax's Website http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  

 


